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1 Das Programm

Zunächst braucht ihr das (kostenlose) Schreibprogramm “Open Office”:

1. Auf der Open Office-Website könnt ihr das Programm herunterladen:

2. Zuerst unter “Wählen Sie das gewünschte System” angeben, ob ihr einen Mac PPC oder

Mac Intel habt – wenn ihr unsicher seid, was euer PC eigentlich ist, könnt ihr unter “Sy-

stemprofil” (auf den blauen Apfel links oben in der Systemleiste klicken und “Über diesen

Mac” auswählen) nachschauen

3. Danach noch auswählen, ob ihr das ganze für einen 10.3 Mac oder einen neueren herun-

terladen wollt (wiederum: wenn ihr unsicher seid, steht das im “Systemprofil”) und auf

“Download starten” klicken

4. Ihr werdet noch gefragt ob ihr X11 schon heruntergeladen habt: Wenn ihr mind. einen 10.3

Mac habt, ist das Programm standardmäßig dabei und ihr könnt sorglos auf “Ok” klicken,

ansonsten auf zB Softonic das (kostenlose) X11 herunterladen:

(a) Auf “Download” klicken,

(b) die Installationsdatei “X11User.dmg” speichern (zB auf dem Desktop) und danach

öffnen – der Download beginnt.

(c) Nach Beendigung des Ladens öffnet sich ein Fenster, in dem sich die Datei “X11User.pkg”

befindet und durch einen Klick auf diese Datei startet die Installation.

(d) “Fortfahren” → “Fortfahren” → “Annehmen” → Speicherort: “Arbeitsplatte” → “Fort-

fahren” → “Aktualisieren” → [kurz Kaffe holen] → “Schließen” klicken – Fertig
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5. Nachdem ihr die darauf folgende Frage, ob ihr die Datei “wirklich runterladen” wollt, be-

herzt mit “Datei speichern” beantwortet habt, werdet ihr noch gefragt, wo ihr sie spei-

chern wollt: wo ihr das tut, ist natürlich euch überlassen, aber da wir erstmal nur die In-

stallationsdatei runterladen, die danach wieder gelöscht werden kann, ist wahrscheinlich der

Bildschirm der empfehlenswerteste Speicherort, da findet man die Sachen erfahrungsgemäß

am schnellsten wieder.

6. Wenn der PC mit dem Herunterladen der Datei fertig ist, geht die eigentliche Installation

los:

(a) Ihr öffnet das eben heruntergeladene Installationsprogramm indem ihr auf das Pro-

grammsymbol, das (in meiner Version) auf dem Bildschirm liegt und “OOo 2.4.1

MacOSXPPC install de.dmg” heißt, klickt.

(b) Nach kurzer Zeit öffnet euer PC dann ein Fenster, in dem unter anderem das blaue

Symbol “OpenOffice org 2.4” liegt – das klickt ihr an und zieht es in den Ordner

“Applications”, der im selben Fenster liegt. Damit kopiert ihr Open Office in eure

Programme und damit auf euren PC.

7. Es ist möglich, dass euer Mac Open Office nur über einen kleinen Umweg öffnen kann: In

diesem Fall öffnet sich, wenn ihr auf das Symbol des nun erfolgreich installiertes OpenOffice

klickt, nicht gleich das Programm selbst, sondern X11, genauer ein xterm-Fenster:

• In dieses Fenster müsst ihr dann den eigentlichen Befehl zum Öffnen des Programms

eingeben1:

sh /Applications/OpenOffice.org 2.4.1.app/Contents/MacOS/soffice

• Ein kleiner Tipp um euch das Leben zu erleichtern: geht im Programm X11 ins Menü

“Applications” und “Customize”, dann könnt ihr euch den Befehl speichern: klickt

auf “Add Item” und gebt einen Namen (naheliegenderweise “Open Office”) und als

“Command” den Befehl von oben ein – dann habt ihr einen Kurzbefehl definiert. Wenn

ihr nun OpenOffice öffnen wollt, öffnet einfach gleich das Programm X11 und klickt

im Menü “Applications” auf euren “Open Office” – Kurzbefehl.

2 Die Schrift

Jetzt braucht ihr noch eine Schriftart, die IPA-Zeichen darstellen kann. Wir haben uns auf Gen-

tium geeinigt, selbstverständlich könnt ihr aber jede Schrift nehmen, die euch gefällt, solange ihr

die IPA-Symbole korrekt einfügen könnt.

1. Im unteren Drittel der Homepage zum Herunterladen der Schrift unter “Downloads” findet

ihr den Link “Download “Gentium 102 W.zip”” für Gentium 1.02 (Windows, Mac OS

X, GNU/Linux) – einfach draufklicken.

2. Nachdem ihr bestätigt habt, dass ihr die Datei “Öffnen” wollt, entpackt er die Zip-Datei

und speichert (im Normalfall auf dem Desktop) den Ordner “Gentium 102”.

1Vorsicht! Was das Programm finden soll, ist die “soffice”-Datei und mit dem Pfad “/Applicati-

ons/OpenOffice.org 2.4.1.app/Contents/MacOS/soffice” sagt ihr ihm, wo genau die liegt, also in diesem Fall im

“Applications”-Ordner, im Unterordner “OpenOffice.orǵ’ usw. – es kann sein, dass bei eurem PC die Verzeichnis-

struktur anders ist als oben angegeben, falls der Befehl also nicht funktioniert, müsst ihr in eurem Finder im Open

Office Ordner “soffice” suchen und eure Ordnerstruktur, die zu “soffice” führt, eingeben.
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3. Wenn ihr den Ordner öffnet, findet ihr (neben einigen .txt-Dateien) 4 Dateien mit der

Endung .ttf – die kopiert ihr nun alle vier in den Ordner /Library/Fonts auf Deinem PC

(am einfachsten öffnet ihr einfach ein neues Finder-Fenster, sucht den Ordner /Fonts und

zieht die Dateien vom Gentium-Ordner da hinein).

3 Arbeiten im Open Office

3.1 Das Schreiben

Mit dem Öffnen von Open Office öffnet sich automatisch ein neues Dokument, in dem ihr nach

Herzenslust schreiben könnt und euren Text auf mannigfache Weise formatieren könnt.

Falls ihr noch nie in einem ähnlichen Textsatzprogramm geschrieben haben solltet, scrollt einfach

mal langsam über all die Icons oben in der Menüleiste – wenn ihr mit dem Cursor jeweils kurz auf

ihnen verharrt, wird ihre jeweilige Bedeutung dann in einem kleinen Fenster erklärt und meist

sind sie auch ganz selbsterklärend, zB B, I oder U für fette, kursive oder unterstrichene Schrift.

Allgemein gilt: eine Formatänderung, zB eine Änderung der Schriftgröße oder -art betrifft jeweils

all den Text, der danach geschrieben wird, bzw. den, der vor der Änderung markiert wurde.

• Noch die paar nützlichsten Kurzbefehle:

Befehl – S Sichern des Dokument

Befehl – A Den ganzen Text markieren

Befehl – C Kopieren (von markiertem Text/Element)

Befehl – X Ausschneiden (von markiertem Text/Element)

Befehl – V Einfügen (von kopiertem/ausgeschnittenem Text/Element)

Befehl – B Text wird fett

Befehl – U Text wird unterstrichen

Befehl – I Text wird kursiv

3.2 Tabellen

In der Menüleiste unter “Table” → “Insert” → “Table” gelangt ihr ein Tabellenzeichenmenü,

in dem ihr einfach eingeben könnt, wieviele Spalten/Zeilen eure Wunschtabelle haben soll und

unter “AutoFormat” könnt ihr euch auch ein schönes Layout aussuchen, wenn ihr das wollt. Dann

einfach auf “Ok” klicken und schon habt ihr eine Tabelle in eurem Dokument, in der ihr wie im

ganz normalen Haupttext schreiben oder Dinge einfügen könnt und euren Text auch ganz normal

formatieren könnt.

Später im Kurs nach der Einführung von Optimalitätstheorie werden 2 notationelle Konventionen

sehr wichtig werden:

• das Symbol +,

das ihr unter “Insert” → “Special Character” findet (die Unicode-Kodierungsnummer,

die rechts unten steht, ist U+ 261E).

Allerdings könnt ihr es nicht mit Gentium einfügen, sondern braucht eine unicode-fähige

Schrift, zB Lucida und als Subset “Miscallaneaus Symbols”.

• das farbige Hinterlegen von Tabellenzellen:

Dazu braucht ihr die Funktion “Background Color”, die entweder oben in eurer Menüzeile

zu finden ist (ein Button mit einem kleinen Farbkreis) oder unter “table” → “Table Pro-

perties” → “Background”. Dort einfach eure Lieblingsfarbe (die im Falle von OT-Tabellen
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immer grau sein wird) einstellen und schon sind alle vorher markierten Tabellenzellen, we-

nigstens aber die, in der sich euer Cursor befindet, farbig.

3.3 IPA-Symbole

Zuallererst müsst ihr Gentium (oder die IPA-fähige Schrift eures Vertrauens) als Schriftart ein-

stellen: in der Menüleiste über eurem leeren Dokument einfach auf den kleinen Pfeil neben dem

Namen der Schrift, die als Standard eingestellt ist (wahrscheinlich “Times New Roman”), klicken,

dann öffnet sich eine Liste mit allen verfügbaren Schriften, in der ihr Gentium suchen und

anklicken könnt. Dann habt ihr 2 Möglichkeiten, IPA-Symbole in den Text zu bekommen:

A. Die Zeichen als Sonderzeichen einfügen

(s. auch die Open Office Anleitung mit nützlichen Tipps):

1. Unter “Insert” → “Special Character” öffnet sich ein kleines Fenster mit Sonderzeichen

– ändert dort den “Font” in Gentium und das “Subset” in “IPA-Extensions”. Jetzt könnt

ihr einfach auf eure gewünschten Zeichen klicken und sie mittels “Ok” in euren Text kopie-

ren. Ihr könnt dort übrigens auch mehrere Zeichen hintereinander anklicken und so ganze

Wörter unproblematisch schreiben: am unteren Rand des Fensters werden alle angeklickten

Sonderzeichen gesammelt und ihr seht, was ihr bis jetzt geschrieben habt.

B. Die Tastaturbelegung eures Macs umstellen:

(erst mal aufwändigere, dann aber praktischere Variante)

1. Dazu von der SIL-HP das Paket IPA Unicode 5.0c Macintosh Keyboard 1.2 herun-

terladen.

a. Die Installationsdatei “IPA-MACkbd.dmg” (klassischerweise auf dem Desktop)

speichern und nach dem Herunterladen öffnen.

b. Nach dem Herunterladen öffnet sich ein Ordner, in der u.a die Datei IPA Unico-

de 5.0c(v1.2) MAC.keylayout liegt, die ihr in den Ordner/Library/Keyboard

Layouts/ kopiert

c. Außerdem habt ihr ein pdf “IPAUni5MAC.pdf” heruntergeladen, das maximal prak-

tisch ist: dort seht ihr die Tastenbelegungen, unter denen ihr die IPA-Symbole finden

könnt, zB “>n” für N.

2. Nun müsst ihr noch das Tastaturmenü umstellen:

a. Geht ihr in eurer “Systemeinstellung” auf “Landeseinstellung” und ins “Tastatur-

menü”. Dort findet ihr eine lange Liste all der Tastaturmenüs, die euer Mac so hat

– sucht euch “IPA Unicode” und setzt einen Haken in das kleine Kästchen davor.

b. Wenn ihr nun auf die kleine Landesfahne, die neben der Uhrzeit in der obersten

Menüleiste zu sehen ist, klickt, könnt ihr die Option “IPA Unicode” anwählen (wahl-

weise könnt ihr auch den Kurzbefehl “Befehl – Leertaste” verwenden, der zwischen

den jeweils letztverwendeten Tastenbelegungen springt).

c. Nun könnt ihr mit den Tastenkombinationen, die ihr in dem pdf’-Dokument gese-

hen habt, alle IPA-Sonderzeichen aufrufen (am empfehlenswertesten ist es, sich die

IPA-Tabelle ganz am Ende einfach auszudrucken). Wahlweise könnt ihr auch unter

dem Landesfahnenmenü “Tastaturübersicht einblenden” einstellen, dann erscheint

ein kleines Fenster mit einer Tastatur, auf der ihr die Tastenbelegung ausprobieren
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könnt: ihr drückt zB “=” und seht dann, welches Zeichen ihr kodiert, wenn ihr jetzt

noch eine weitere Taste drückt.

3.4 Das Dokument als pdf senden

Schlussendlich müsst ihr euer Dokument nun noch im (für alle Betriebssysteme lesbaren) Datei-

format PDF sichern und versenden können (im Fall eurer Phonologiehausaufgaben an den Tutor

eures Vertrauens):

1. unter “File” “Export as PDF” anklicken.

2. Ihr werdet noch einmal gefragt, wie euer Dokument heißen soll und wo ihr es speichern

wollt: im Standardfall einfach “Ok” klicken.

3. Und könnt danach noch einige Einsteölungen ändern, zB welche Seiten eures Open Office

Dokuments ihr ins PDF-Fomat überführen wollt. Im Normalfall klickt ihr einfach “Export”

und schon habt ihr ein PDF erstellt.

Um das ganze nun über euren Uniaccount als Mail zu versenden, müsst ihr zunächst auf die

Seite https: //mail.uni-leipzig.de. gehen. Dort als E-Mail-Server “studserv (imap)” (die zweite

Option in der Liste) angeben und Benutzername und Passwort eingeben, die ihr beide von der

Uni bekommen habt. Der Login ist dabei derselbe, mit dem ihr euch im Rechenzentrum einloggt,

i.e. eine Kombination aus 3 Buchstaben (=Fachbereichsabkürzung), 2 Zahlen (=Immatrikulati-

onsjahr) und nochmal 3 (diesmal sinnlosen) Buchstaben.

Nach dem Einloggen gelangt ihr in euren Unimailaccount, der wie jeder andere mailaccount auch

fubnktioniert:

1. mit dem Button “Neue Nachricht” öfnet sich ein leere mail, in deren Textfeld ihr anch

Herzenslust schreiben könnt.

2. Unter dem Textfeld eurer mail gibt es den Abschnitt “Anhänge” – wenn ihr dort auf

“Durchsuchen” klickt, könnt ihr auf eurem pc nach der Datei suchen, die ihr gern verschiken

wollt, indem ihr euch durch eure Ordner navigiert.

3. Mit einem Doppelklick auf die Datei höngt ihr sie an eure mail und zugleich erscheint eine

Zeile “Dokument 2” – ihr köönt also beliebig viele Dateeina n eure mail hängen.

4. dann einfach noch eine Adresse in die “An” - Zeile und mit “Senden” führt ihr euer PDF

dem Ort seiner Bestimmung zu...

5. (und nicht den Button “Abmelden” ganz links vergessen...)
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